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About 

Welcome to Ekran System! 

This guide will help you deploy Ekran System components and configure them to function 
properly in the High Availability mode using Microsoft Failover Cluster. 
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System Requirements  

Ekran System claims different system requirements for each of its components. Make sure 

your hardware and software meet the following system requirements to avoid possible 

component malfunctions. 

Server requirements 

 CPU (depending on deployment scale):  

o Small Deployment (Up to 200 simultaneous sessions): 4-8 Cores 
o Medium Deployment (Up to 1000 simultaneous sessions): 8-16 Cores 
o Large Deployment (Up to 10 000 simultaneous sessions): 16-32 Cores 

 RAM: 8-16 Gb  

 1 GB Ethernet (10 GB Ethernet is recommended) 

 Windows Server 2019, Windows Server 2016, Windows Server 2012 

 Universal C Runtime and Visual C++ Runtime (starting with Ekran System 5.5). Both can 
be installed via the Microsoft Visual C++ 2015 Redistributable: 
https://www.microsoft.com/en-gb/download/details.aspx?id=48145 

NOTE: The Universal C Runtime needs to be initially installed via update 

KB2999226: https://support.microsoft.com/en-us/help/2999226/update-for-universal-
c-runtimein-windows 

 .Net Framework 4.8 

 

Database requirements 

 [When using MS SQL Database]: Full edition of MS SQL Server 2019, MS SQL Server 

2017, MS SQL Server 2016, MS SQL Server 2014, MS SQL Server 2012, MS SQL Server 

2008R2. Standard license or higher is required.  

 [When using PostgreSQL Database]: PostgreSQL 10 or higher 

 Depending on deployment scale: 

Small Deployment (Up to 200 simultaneous sessions):  

 CPU: 4-8 Cores 

 RAM: 16 GB 

Medium Deployment (Up to 1000 simultaneous sessions):  

 CPU: 8-16 Cores 

 RAM: 24-32 GB 

Large Deployment (Up to 10 000 simultaneous sessions):  

 CPU: 16-32 Cores 

 RAM: 64-128 GB 

 1 GB Ethernet (10 GB Ethernet is recommended) 

 Windows Server 2019, Windows Server 2016, Windows Server 2012, and Windows 

Server 2008 R2 (x64 platform) 

https://www.microsoft.com/en-gb/download/details.aspx?id=48145
https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtimein-windows
https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtimein-windows
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 It is recommended to have enough free space depending on the volume and frequency 

of monitoring and the retention period of the Client monitoring data (on average, 1 

Workstation Client generates 200-300 MB per 8-hour working day. For more 

information, see System Requirements and Performance Numbers guide) 

 

Binary Data Storage requirements (when binary data received from Clients is stored in a 
shared or local folder) 

 Operating System hard disk: 100-200 GB (15K or SSD) 

 It is recommended to have enough free space depending on the volume and frequency 
of monitoring and the retention period of the Client monitoring data (on average, 1 
Workstation Client generates 200-300 MB per 8-hour working day. For more 
information, see System Requirements and Performance Numbers guide) 

 

Microsoft Failover Cluster requirements 

 All servers that you want to add as cluster nodes must be running the same version of 
Windows Server. 

 All servers that you want to add as cluster nodes must be joined to the same Active 
Directory domain. 

 The account you want to use to create the cluster must be a domain user who has 
administrator rights on all servers that you want to add as cluster nodes. 

  

https://www.ekransystem.com/sites/default/files/file_resources/Ekran%20System%20%20Requirements%20and%20Performance%20Numbers.pdf
https://www.ekransystem.com/sites/default/files/file_resources/Ekran%20System%20%20Requirements%20and%20Performance%20Numbers.pdf
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Program Structure 

Ekran System is an application specially designed to monitor user activity remotely. 

Ekran System includes the following components: 

 Ekran System Server (further referred to as Server) 

 Ekran System Management Tool (further referred to as Management Tool), which acts 
as a single access point for the administrators. 

 Ekran System Clients (further referred to as Clients) 

 

Fig.1. General deployment scheme 

The High Availability mode allows you to configure and deploy Ekran System in such a way that 
if the Ekran Server stops functioning for any reason, another Ekran Server instance can replace 
it without data loss and reinstallation of the system. 
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Deployment Process 

About 

The deployment of High Availability Ekran System consists of the following steps: 

Step 1. Deploy the failover cluster using the Microsoft Failover Clustering feature. 

Step 2 (optional). Add shared storage to the failover cluster. 

Step 3. Install Ekran Server on the failover cluster nodes and connect to the existing SQL server. 

Step 4. Configure all Ekran Server instances. 

Step 5. Create a role for Ekran Server in the Failover Cluster Manager. 

Step 6. Complete the prerequisites and install Management Tool. 

Step 7. Activate serial keys (add activated serial keys). 

Step 8. Install Clients. 

After installing all the system components, High Availability Ekran System is considered 
deployed. 

In case of the Ekran Server failure, the Failover Cluster Manager automatically restores the 
system by using the backup Ekran Server instance.  
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Step 1. Failover Cluster deployment 

To create a failover cluster, you must install the Failover Clustering feature on every server that 
you want to add as a failover cluster node with an Ekran Server instance. 

 

The deployment of the Failover Cluster consists of the following steps: 

Step 1. Install the Failover Clustering feature on every server. 

Step 2. Validate the configuration on every server. 

Step 3. Create the failover cluster. 

 

NOTE: For more information on deploying the Failover Cluster, see the Microsoft 
documentation at https://docs.microsoft.com/en-us/windows-server/failover-
clustering/failover-clustering-overview 

 

Before installing the Failover Clustering feature, make sure the following account requirements 
are met:  

 The account you want to use to create the cluster is a domain user who has 
administrator rights on all servers that you want to add as cluster nodes. 

 The user who creates the cluster has the Create Computer objects permission to the 
organizational unit in the domain. 

 

To install the Failover Clustering feature, do the following: 

1. Start Server Manager. 

 

https://docs.microsoft.com/en-us/windows-server/failover-clustering/failover-clustering-overview
https://docs.microsoft.com/en-us/windows-server/failover-clustering/failover-clustering-overview
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2. On the Manage menu, select Add Roles and Features. 

 

3. On the Before you begin page, click Next. 

4. On the Select installation type page, select Role-based or feature-based installation, 
and then click Next. 

5. On the Select destination server page, select the server where you want to install the 
feature, and then click Next. 

6. On the Select server roles page, click Next. 

7. On the Select features page, select the Failover Clustering option. 

 

8. To install the failover cluster management tools, select Add Features, and then click 
Next. 
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9. On the Confirm installation selections page, click Install. 

10. When the installation is completed, click Close. 

 

NOTE: Repeat this procedure on every server that you want to add as a failover cluster node. 

 

To validate the configuration, do the following: 

1. Start Server Manager on the server where the Failover Clustering feature was installed. 

2. On the Tools menu, select Failover Cluster Manager. 

 

3. In the Failover Cluster Manager window, in the Actions pane, select Validate 
Configuration. 

 

4. On the Before You Begin page, click Next. 



 

  

11 

 

5. On the Select Servers or a Cluster page, in the Enter name box, enter the NetBIOS name 
or the fully qualified domain name of all servers that you plan to add as failover cluster 
nodes. Click Next. 

 

6. On the Testing Options page, select Run all tests (recommended), and then click Next. 

7. On the Confirmation page, click Next. 

8. The Validating page displays the status of the running tests. 

9. On the Summary page, do either of the following: 

 If the results indicate that the tests completed successfully and the configuration is 
suited for clustering, click Finish. 

 If the results indicate that there were warnings or failures, select View Report to 
view the details and determine which issues must be corrected. It is recommended 
to fix the detected warnings and be sure to fix the detected failures. 

 

NOTE: Repeat this procedure on every server that you want to add as a failover cluster node. 

 

To create the failover cluster, do the following: 

1. Start Server Manager. 

2. On the Tools menu, select Failover Cluster Manager. 

3. In the Failover Cluster Manager window, in the Actions pane, select Create Cluster. 
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4. On the Before You Begin page, click Next. 

5. On the Select Servers or a Cluster page, in the Enter name box, enter the NetBIOS name 
or the fully qualified domain name of all servers that you plan to add as failover cluster 
nodes. Click Next. 

6. On the Access Point for Administering the Cluster page, in the Cluster Name box, enter 
the name that you want to use to administer the cluster.  

7. Select the check box next to each network that you want to use for cluster 
management. Select the Address field next to a selected network, and then enter the IP 
address that you want to assign to the cluster. Click Next.  
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8. Click Next to create the failover cluster. 

9. On the Summary page, confirm that the failover cluster was successfully created. 

 

NOTE: This procedure must be performed only once on any of the servers that you want to 
add as failover cluster nodes. To be able to manage the failover cluster from other nodes, 
simply connect to the already created cluster in the Failover Cluster Manager using the 
cluster name or IP address. 

 

Step 2 (optional). Configuration of shared storage  

If necessary, you can store binary data received from Clients in shared storage on 

a standalone computer. This may be necessary to store large amounts of data. 

 

There are different types of storages and deployment options. One of them is the Shared 
Storage via iSCSI with Microsoft Failover Clustering, which includes the following deployment 
steps: 

Step 1. Install the iSCSI Target Server role on a standalone storage server. 

Step 2. Create an iSCSI virtual disk. 

Step 3. Connect the virtual disk to every failover cluster node. 

Step 4. Add the virtual disk to the failover cluster. 

 

NOTE: To use the Multipath I/O feature, the standalone storage server must have two 
network interfaces. 

 

To install the iSCSI Target Server role, do the next: 

1. Start Server Manager on the server which you want to use as shared storage. 

2. On the Manage menu, select Add Roles and Features. 
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3. On the Before you begin page, click Next. 

4. On the Select installation type page, select Role-based or feature-based installation, 
and then click Next. 

5. On the Select destination server page, select the server where you want to install the 
role, and then click Next. 

6. On the Select server roles page, expand File and Storage Services, expand File and iSCSI 
Services, and then select the iSCSI Target Server option. 

 

7. On the Confirm installation selections page, click Install. 

8. When the installation is completed, click Close. 

 

To create an iSCSI virtual disk, do the next: 

1. Start Server Manager on the server which has the iSCSI Target Server role installed. 

2. In the left pane, select File and Storage Services. 
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3. Select iSCSI and click To create an iSCSI virtual disk, start the new iSCSI Virtual Disk 
Wizard. 

 

4. Select a disk on which you want to create shared storage. 
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5. Enter a virtual disk name. 

 

6. Set the virtual disk size and select its type (or keep the default one). 

 

7. On the iSCSI Target page, keep the New iSCSI target option selected, if you don’t have 
one already created. 
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8. Enter a name for the new iSCSI target. 

 

9. On the Access Servers page, use the Add button to add the server that you have 
configured as a failover cluster node. You can use the DNS Name, IP address or other 
options to refer to that server. 
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10. Repeat the Add procedure for every server that has been configured as a failover cluster 
node. 
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11. On the Confirmation page, click Create. 

12. When the creation is completed, click Close. 

 

To connect the virtual disk to a cluster node, do the following: 

1. Start Server Manager on the server, which you have configured as a failover cluster 
node. 

2. On the Manage menu, select Add Roles and Features. 

3. On the Before you begin page, click Next. 

4. On the Select installation type page, select Role-based or feature-based installation, 
and then click Next. 

5. On the Select destination server page, select the server where you want to install the 
feature, and then click Next. 

6. On the Select server roles page, click Next. 

7. On the Select features page, select the Multipath I/O option. 

 

8. On the Confirm installation selections page, click Install. 

9. When the installation is completed, click Close. 

NOTE: Restart the server after installation of the feature. 

10. From the Start menu, select Administrative Tools, and then select MPIO. 
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11. Open the Discover Multi-Paths tab, select the Add support for iSCSI devices option and 
click Add. 

  

NOTE: Restart the server after adding this option. 
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12. From the Start menu, select Administrative Tools, and then select iSCSI Initiator. 

 

13. Click Yes to start the iSCSI service. 

 

14. In the iSCSI Initiator Properties window, open the Discovery tab and click Discover 
Portal. 
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15. Enter the IP address or DNS name of the data storage server with the iSCSI Target Server 
role installed, and click OK. 
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NOTE: If there is no connection to the target, make sure that a firewall exception rule 
for the 3260 port is added on the data storage server. 

16. In the iSCSI Initiator Properties window, open the Targets tab and click Connect. 

 

17. In the Connect To Target window, select the Enable multi-path option and click 
Advanced. 
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18. In the Advanced Settings window, select the first IP address of the data storage server 
with the iSCSI Target Server role installed, and click OK. 

 

19. In the iSCSI Initiator Properties window, on the Targets tab, click Properties. 
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20. In the Properties window, click Add session. 

 

21. In the Connect To Target window, select the Enable multi-path option and click 
Advanced. 
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22. In the Advanced Settings window, select the second IP address of the data storage 
server with the iSCSI Target Server role installed and click OK to close the iSCSI Initiator 
Properties window. 

 

23. Press Win+R and type diskmgmt.msc to open Disk Manager. 
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24. Right-click the new disk and click Online. 

 

25. Right-click and click Initialize. You can select a partition style. 

 

26. Right-click the unallocated space of the new disk and create a new volume. 
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27. Enter a name for the new volume. 

 

28. You can see the new disk in File Explorer. 
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NOTE: Repeat this procedure on every server that you have added as a failover cluster node. 

 

To add the shared virtual disk into the failover cluster, do the following: 

1. Start Server Manager on any server, which you have configured as a failover cluster 
node. 

2. On the Tools menu, select the Failover Cluster Manager. 

3. In the Failover Cluster Manager window, in the Actions pane, select Validate Cluster. 
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4. On the Testing Options page, select Run only tests I select, and then click Next. 

 

5. On the Test Selection page, select only the Storage option, and click Next. 
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6. On the Confirmation page, click Next. 

7. The Validating page displays the status of the running tests. 

8. On the Summary page, do either of the following: 

 If the results indicate that the tests completed successfully and the configuration is 
suited for storage adding, click Finish. 

 If the results indicate that there were warnings or failures, select View Report to 
view the details and determine which issues must be corrected. It is recommended 
to fix the detected warnings and be sure to fix the detected failures. 

9. In the left pane of the Failover Cluster Manager, expand the failover cluster node, 
expand the Storage node, and then select Disks. 

 

10. In the Actions pane of the Failover Cluster Manager, click Add disk and select the shared 
virtual disk. 
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11. You can see the virtual disk added to the cluster. 

 

Step 3. Servers Installation 

There are two stages of Servers installation: 

Stage 1. The first Server instance is installed. During installation, you can select an existing 
database or create a new one. 

Stage 2. Subsequent Server instances are installed. During installation, you have to select the 
same database the first Server instance connects to. 

NOTE: It is highly recommended to configure the SQL Server failover cluster. For more 
information, see the Microsoft Documents. 

 

To install the Server, do the following: 

1. Run the EkranSystem_Components.exe installation file. 

2. Click Next on the Welcome page. 

3. Carefully read the terms of the End-User License Agreement and click I Agree. 

4. On the Choose Components page, do one of the following and click Next: 

 In the drop-down list, select Ekran System Server. 

 Select Ekran System Server in the box. 

5. On the Choose Install Location page, enter the installation path or click Browse to navigate 
to the Server installation folder. Click Next. 

https://docs.microsoft.com/en-us/sql/sql-server/failover-clusters/install/create-a-new-sql-server-failover-cluster-setup?view=sql-server-ver15
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6. On the Database Type page, select the type of the database you want to use for 

storing data. Click Next. 

NOTE: If you have already created database, select its type, and then define the 

connection parameters for this database. 

7. If you have selected PostgreSQL, on the PostgreSQL Server Database 

Configuration page, define the connection parameters and then click Next. 

 Define the PostgreSQL Server instance name, which is the instance name 

assigned to the TCP/IP port. Optionally, you can define the custom 

PostgreSQL database port by entering it after the Server instance name and 

separating with colon (e.g.,<server_instance_name>:<port>). 

NOTE: If the default instance of the PostgreSQL is used, enter localhost 

in the Server instance field. 

 Define the Database name for the database. 

 Define the User name and Password of a user account via which the 

connection to the Server will be established. 

NOTE: By default, it is a user with the login postgres and the password 

defined during the PostgreSQL installation. 

8. If you have selected MS SQL Server, on the MS SQL Server Database Configuration 

page, define the connection parameters and then click Next. 

 Define the MS SQL Server instance name, which is the instance name 

assigned to the TCP/IP port. Optionally, you can define the custom MS SQL 

database port by entering it after the Server instance name and separating 

with comma (e.g.,<server_instance_name>,<port>). 

NOTE: If the default instance of the MS SQL is used, then only name of 

the PC with the MS SQL server must be defined. 

 Define the Database name for the database. 

 Select the type of authentication: SQL Server Authentication or Windows 
Authentication.  

 If using SQL Server Authentication, define the SQL Server User name and Password of a 
user account via which the connection to the Server will be established. 

NOTE: You have to define either the SA credentials or the credentials of the user 
with the dbcreator permission. 

 If using Windows Authentication, enter the User name as domain name\user name and 
specify the Password. 

NOTE: The specified user must be added as a user in SQL and have the sys_admin 
permission. 

9. If you already have a database created manually or during the usage of previous 

program versions, you will be offered to use it. If you want to use the existing 
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database, click Yes. In other case, click No and the new database will be created. 

NOTE: If you click No, the existing database will be deleted. 

10. To store binary data received from Clients in shared storage, define the path to the required 
folder: 

o The shared folder location must be defined as \\<computer IP>\<folder path> or 
\\<computer name>\<folder path> (e.g., \\admin-pc\SharedFolder).  

o If the shared storage was configured, the shared storage location must be defined as 
<shared storage path> (e.g., D:\) 

NOTE: Make sure the defined path is accessible on each failover cluster node.   

11. On the Administrator password page, define the password for the administrator 

(the default user of Ekran System with login admin and full permissions). Click 

Next. 

12. On the Client Uninstallation Key page, enter the key that will be used during the 

Client local uninstallation and click Next. By default, the Uninstallation key is 

allowed. You will be able to change this key via the Management Tool any time 

later. 

13. Click Install. 

14. The installation process starts. Its progress is displayed on the Installing page. 

15. After the end of the installation process, click Finish to exit the wizard. 

16. Back up EkranMasterCertificate (only on the first Server instance). 

17. In Windows Firewall, you must allow the Server executable to accept TCP 

connections via port 9447 (for the connection between the Server and the Clients), 

22712, 22713, and 22714 (for the connection between the Server and the 

Management Tool). These rules will be added to Windows Firewall automatically if 

Windows Firewall is enabled during the Server installation. 

 

Step 4. Configuration of Ekran Server instances 

After you installed the Server on all failover cluster nodes, you need to configure all Server 
instances. 

 

On the first Ekran instance do the following: 

1. Stop the EkranServer service. 

2. Open the Windows Registry Editor. 

3. In the Registry Editor window, select the 
HKEY_LOCAL_MACHINE\SOFTWARE\EkranSystem key. 

4. Select Edit > New > DWORD Value > and add a new value: 

 Value name: UseLegacyHwid 
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 Value data: 0 

5. Start the EkranServer service. 

 

On each subsequent Server instances, do the following: 

1. Stop the EkranServer service. 

2. Delete the existing EkranMasterCertificate from the Windows Certificate store and 
import the one backed up on the first Ekran Server instance. 

NOTE: Do not start the EkranServer services. It will be started by the Failover Cluster 
Manager in case of failure of the first Ekran instance.  

Step 5. Configuration of the Ekran Server role in the 
failover cluster 

To monitor the health of not only the failover cluster node that is currently being used, but also 
the Ekran Server service running on it, you must create a role for this service in the Failover 
Cluster Manager. 

 

To create a role for Ekran Server services, do the following: 

1. Start Server Manager on the first Ekran instance of Ekran Server. 

2. On the Tools menu, select the Failover Cluster Manager. 

3. In the Failover Cluster Manager window, expand the failover cluster in the left pane and 
select Roles. In the Actions pane, click Configure Role. 

 

4. On the Select Role page, click Generic Service. 
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5. On the Select Service page, select EkranServer. 

 

6. On the Client Access Point page, define a name for the role and its IP address. By these 
identifiers, Clients and Management Tool connect to the Ekran Server service through 
the network. 
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7. On the Replicate Registry Settings page, click Add to specify the Ekran Server registry 
key: SOFTWARE\EkranSystem. 

 

8. Proceed to the confirmation step and click Finish when the role is created. 
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9. In the Failover Cluster Manager window, expand the failover cluster in the left pane and 
select Roles.  

10. In the Roles grid, select the role created for the Ekran Server service. 

11. In the Actions pane, select Properties. 

12. In the opened window, on the Failover tab, specify the Maximum failures in the 
specified period and Period (hours) options. Click OK. 

13. You can see the status of the created role in the Failover Cluster Manager. 

 

 

To verify that switching between the nodes works, do the following: 

1. Start Server Manager on the first Ekran instance. 

2. On the Tools menu, select the Failover Cluster Manager. 

3. In the Failover Cluster Manager window, in the left pane, expand the failover cluster 
node and click Roles. Select the created role for the Ekran Server service and click Move 
in the Actions pane. 

 

4. Click Select Node. 
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5. Select another node with the Ekran Server instance installed. 

 

6. You can see that the role owner has changed to the selected node. The Ekran Server 
service on the previous node has stopped, and on the new node (new role owner) it has 
started automatically. 
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Step 6. Management Tool Installation 

For detailed information on completing installation prerequisites and installing the 
Management Tool, please refer to the User Manual or the Deployment Guide. 

 

Install Management Tool on a separate computer. During installation, on the Connection 
Settings page, in the Server address box, enter the name or IP address that was defined for the 
Ekran Server role in the failover cluster. 

 

NOTE: Optionally, you can install the Management Tool on several separate computers. 
During the installation of each subsequent Management Tool, define the name or IP address 
that was specified for the Ekran Server role in the failover cluster.  
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Step 7. Serial Key Activation 

About 

To be able to receive data from the Clients, you need to license the Clients by activating 
purchased serial keys.  

Activating Serial Keys Online 

To activate purchased serial keys online, do the following: 

1. Make sure you have an active Internet connection in the failover cluster. 

2. Log in to the Management Tool as a user of the Administrators user group. 

3. Click the Serial Key Management navigation link to the left. 

4. On the Serial Keys tab, click Activate keys online. 

5. In the Serial Key Activation window, enter serial keys to be activated separating them with 
semicolons or paragraphs and click Activate. 

6. The activated keys appear on the Serial Key Management page. 

7. The number of available licenses and the update & support period end date change. 

Adding Activated Serial Keys Offline 

If you have no Internet connection in the failover cluster environment, you can activate serial 
keys on the license site and then add the activated serial keys offline. For more information, 
send an email to info@ekransystem.com  

NOTE: Update and Support serial keys cannot be activated offline. 

 

To activate serial keys offline on the license site, do the following: 

1. On the failover cluster node, which currently owns the Ekran Server role and on which the 
Ekran Server service is running, start the UniqueIdentifierGenerator.exe file, which you can 
download at 
https://www.ekransystem.com/sites/default/files/ekransystem/UniqueIdentifierGenerator.exe  

2. The Unique Identifier Generator window opens. 

3. Click Generate to generate a unique identifier. 

4. When a unique identifier is generated, it will appear in a text box under the Unique Identifier 
group of options. 

5. Copy the unique identifier from the text box to a text file on a removable drive. 

6. Go to the license site. 

7. Enter the generated unique identifier in the Unique Identifier box. 

8. Copy and paste the purchased serial keys to the Serial Keys box separating them with 
paragraphs or spaces. 

mailto:info@ekransystem.com
https://www.ekransystem.com/sites/default/files/ekransystem/UniqueIdentifierGenerator.exe
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9. Enter the CAPTCHA text in a text box near the CAPTCHA image. 

10. Click Activate. 

11. The activatedKeys.txt file will be generated. Save the file on a removable drive. 

12. Copy the file to the host on which you will open the Management Tool. 

NOTE: Please do not edit the generated file activatedKeys.txt. 

 

To add activated serial keys in offline mode, do the following: 

1. Log in to the Management Tool as a user of the Administrators user group. 

2. Click the Serial Key Management navigation link to the left. 

3. On the Serial Keys tab, click Add activated keys. 

4. On the Activated Serial Key Adding page, click Choose File and navigate to the 
activatedKeys.txt file with activated serial keys. 

5. Click Add. 

6. The newly added serial keys appear on the Serial Key Management page. 

7. The number of available licenses and the update & support period end date change. 

8. If there are both licensed and unlicensed Clients in your network and you want to license the 
rest of Clients with a purchased key, you will have to assign the license to the remaining 
unlicensed Clients manually. 

Step 8. Client Installation 

Windows Clients 

For detailed information on installing the Clients, please refer to the User Manual or the 
Deployment Guide. 

There are several types of Windows Clients installation: 

 During remote installation via the Management Tool, on the Client configuration page, 
in the Server name/IP field, enter the name or IP address that was defined for the Ekran 
Server role in the failover cluster. 
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 During generation of the installation package for local installation, on the Generate 
Installation Package page, in the Server name/IP field, enter the name or IP address 
that was defined for the Ekran Server role in the failover cluster. 

 During local installation without the .ini file, in the Ekran System Local Client 
Installation window, enter the name or IP address that was defined for the Ekran Server 
role in the failover cluster. 

macOS Clients 

For detailed information on installing the Clients, please refer to the User Manual or the 
Deployment Guide. 

During the Client installation, run the macOS Client installation script specifying the name or IP 
address that was defined for the Ekran Server role in the failover cluster: 

./install.sh <cluster_role_name or IP address> <server_port> 

Linux Clients 

For detailed information on installing the Clients, please refer to the User Manual or the 
Deployment Guide. 

During the Client installation, run the Linux Client installation script specifying the name or IP 
address that was defined for the Ekran Server role in the failover cluster: 

$ sudo ./install.sh <cluster_role_name or IP address> <server_port> 
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System Recovery Process 

If the Ekran Server service running on the current node (role owner) fails or the node itself fails, 
the Failover Cluster Manager will automatically move the Ekran Server role to the next available 
node and start the Ekran Server service on it. All data recorded using the failed node will be 
available on the new node.  

You can investigate the cause of the failure and fix the issue so that this node can be used as a 
backup in case of future failures if any. 
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Server Update Process 

About 

The Ekran System Server configured on multiple nodes in the Microsoft Failover Cluster mode 

can be updated using the Cluster-Aware Updating (CAU) feature. This feature automates the 

software updating process on clustered servers while maintaining availability.  

NOTE: For more information on the Cluster-Aware Updating (CAU) feature, see the Microsoft 

documentation at https://docs.microsoft.com/en-us/windows-server/failover-

clustering/cluster-aware-updating 

There are two Cluster-Aware Updating modes: 

 Self-updating mode. This mode is configured on the cluster nodes. The update is 

performed on a scheduled basis. In addition, an administrator can manually trigger 

updates on-demand in this mode.  

 Remote-updating mode. This mode is configured on a remote computer (the Update 

Coordinator). From the remote computer, an administrator triggers an on-demand 

update. 
 

Prerequisites 

Both updating modes require the following prerequisites:  

 Failover Cluster Tools must be installed 

 Server Message Block (SMB) file share must be configured 

 

Failover Clustering Tools 

In self-updating mode, the Failover Clustering Tools must be installed on each node of the 

failover cluster. In remote-updating mode, the Failover Clustering Tools must be installed on 

the remote Update Coordinator computer.  

To install the Failover Clustering Tools, do the following: 

1. Start Server Manager. 

2. On the Manage menu, select Add Roles and Features. 

3. On the Before you begin page, click Next. 

4. On the Select installation type page, select Role-based or feature-based installation, and 

then click Next. 

5. On the Select destination server page, select the server where you want to install the 

feature, and then click Next. 

6. On the Select server roles page, click Next. 

https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-updating
https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-updating
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7. On the Select features page, select the Failover Clustering option. 

8. Click Add Features, and then click Next. 

 

9. On the Confirm installation selections page, click Install. 

10. When the installation is completed, click Close. 

 

Server Message Block file share 

Newer versions of Ekran System Sever must be distributed between cluster nodes from a Server 

Message Block (SMB) file share. Make sure that the file share is accessible from all of the cluster 

nodes and the remote Update Coordinator computer (in case of remote-updating mode).  

The account that is used for updating must be added as a local administrator account on the 

SMB server. If this is not allowed due to security policies in your organization, configure the 

account with the required permissions using the instructions at https://docs.microsoft.com/en-

us/windows-server/failover-clustering/cluster-aware-updating-plug-ins#to-configure-a-user-

account-on-the-smb-server 

To configure an SMB file share, do the following: 

1. Create a shared folder on the SMB server. 

2. Copy the DefaultHotfixConfig.xml configuration file to the shared folder. The 

DefaultHotfixConfig.xml file is located in the following path on the computer where the 

CAU tools are installed: 

%systemroot%\System32\WindowsPowerShell\v1.0\Modules\ClusterAwareUpdating\ 

3. In the shared folder, create a subfolder named CAUHotfix_All. 

4. In the CAUHotfix_All folder, create a subfolder for Ekran System files. New versions of 

Ekran System Server will be stored there. 

An example of a shared folder structure: 

\\FileServer\EkranServerUpdates\ 

https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-updating-plug-ins#to-configure-a-user-account-on-the-smb-server
https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-updating-plug-ins#to-configure-a-user-account-on-the-smb-server
https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-updating-plug-ins#to-configure-a-user-account-on-the-smb-server
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    DefaultHotfixConfig.xml 

    CAUHotfix_All\ 

        EkranServer\ 

5. Modify the DefaultHotfixConfig.xml configuration file:  

 In the Default Rules section, add the Folder Rules section.  

 Specify the Folder name parameter as the name of the subfolder created in the 

CAUHotfix_All folder. In the example, the Folder name parameter is specified as 

EkranServer. 
<?xml version="1.0" encoding="utf-8"?> 

<?Copyright (c) Microsoft Corporation. All rights reserved.?> 

<root> 

    <DefaultRules> 

        . . . 

        . . . 

        . . . 

    </DefaultRules> 

    <!-- Rule to install Ekran Server updates --> 

    <FolderRules> 

        <!-- Folder name must be as the one in “CAUHotfix_All” --> 

        <Folder name="EkranServer" alwaysReboot="false">       

            <Template path="$update$" parameters="/S"/> 

            <ExitConditions> 

                <Success> 

                    <ExitCode code="0"/> 

                </Success> 

            </ExitConditions> 

        </Folder> 

    </FolderRules> 

</root> 

6. Configure settings for SMB data integrity. Optionally, enable SMB Encryption for the 

SMB shared folder by using the following PowerShell cmdlet on the SMB server: 
Set-SmbShare <ShareName> -EncryptData $true 

For more information, see the Microsoft documentation at 

https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-

updating-plug-ins#step-4-configure-settings-for-smb-data-integrity 

Self-Updating Mode 

To configure Cluster-Aware Updating in the self-updating mode, do the following: 

1. Start Server Manager on any server, which you have configured as a failover cluster 

node. 

2. On the Tools menu, select the Failover Cluster Manager. 

3. In the Failover Cluster Manager window, in the Actions pane, click More actions, and 

then select Cluster-Aware Updating. 

https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-updating-plug-ins#step-4-configure-settings-for-smb-data-integrity
https://docs.microsoft.com/en-us/windows-server/failover-clustering/cluster-aware-updating-plug-ins#step-4-configure-settings-for-smb-data-integrity
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4. In the Cluster Actions pane, select Configure cluster self-updating options.

 
5. On the Getting Started page, click Next. 

6. On the Add Clustered Role page, select the Add the CAU clustered role, with self-

updating mode enabled, to this cluster option, and then click Next. 

 
7. On the Self-updating schedule page, specify the frequency, date, and time of self-

updating. 
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8. On the Advanced Options page, set the CauPluginName parameter to 

Microsoft.HotfixPlugin, and then click Next.

 
9. On the Additional Options page, do the following, and then click Next: 

 Enter the path to the root folder with the update files and wait until it is verified 

 Select the Require SMB encryption in accessing the hotfix root folder option if 

SMB Encryption for the SMB shared folder has been configured on the SMB 

server 

 Select the Disable check for administrator access to the hotfix root folder and 

configuration file option 

 

10. On the Confirmation page, click Apply. 
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After the self-updating mode is configured and the new version of Ekran System Server is 

uploaded to the shared folder, the installation will start automatically on schedule. You can 

start it manually at any time using the Apply updates to this cluster option. 

 

Remote-updating mode 

To update Ekran System using Cluster-Aware Updating in the remote-updating mode, upload 

the new version of Ekran System Server to the shared folder and run the following PowerShell 

cmdlet on the remote Update Coordinator computer: 

Invoke-CauRun -ClusterName <cluster_name> -CauPluginName 

Microsoft.HotfixPlugin -CauPluginArguments @{ 'HotfixRootFolderPath' = 

<path_to_the_share>; 'RequireSmbEncryption' = 'True'; 'DisableAclChecks' = 

'True'; 'HotfixConfigFileName' = 'DefaultHotfixConfig.xml' } -

EnableFirewallRules -Force 
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Managing Ekran Master Certificate 

Opening Certificates Snap-in 

To open the Certificates snap-in, do the following: 

1. On the Ekran Server computer with the certificate you want to back up, press Windows+R, 
type mmc in the Run text box and press Enter. 

2. In the opened User Account Control window, click Yes. 

3. In the Console window, select File > Add/Remove Snap-in. 

4. In the Add or Remove Snap-ins window, select Certificates and click Add. 

5. In the Certificates Snap-in window, select the Computer account option and click Next. 

6. In the Select Computer window, select the Local computer option and click Finish. 

7. In the Add or Remove Snap-ins window, click OK. 

 

Backing up Ekran Master Certificate 

To export Ekran Master Certificate, do the following: 

1. Open the Certificates snap-in. 

2. In the Certificates (Local computer) tree-view, select Personal > Certificates. 

3. Select EkranMasterCertificate and in its context menu select All Tasks > Export. 

4. The Certificate Export Wizard opens. 

5. On the Certificate Export Wizard Welcome page, click Next. 

6. On the Export Private Key page, select the Yes, export the private key option and click Next. 

7. On the Export File Format page, select the following options and click Next: 

- Personal Information Exchange 

- Include all certificates in the certification path if possible 

- Export all extended properties 

8. On the Security page, select the Password option and enter the password in the Password 
and the Confirm password fields. Click Next. 

NOTE: Make sure that you remember the password since you will need it when restoring the 
certificate or transferring it to another server. 

9. On the File to Export page, define the location to store the certificate and the certificate 
name, and click Next. 

10. On the Completing the Certificate Export Wizard page, click Finish. 
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Deleting Ekran Master Certificate 

To delete Ekran Master Certificate, do the following: 

1. Open the Certificates snap-in. 

2. In the Certificates (Local computer) tree-view, select Personal > Certificates. 

3. Select EkranMasterCertificate and in its context menu select Delete. 

4. Click Yes in the confirmation message. 

 

Importing Ekran Master Certificate 

To import Ekran Master Certificate, do the following: 

1. Open the Certificates snap-in. 

2. In the Certificates (Local computer) tree-view, select Personal > Certificates. 

3. In the Console window, select Actions > All Tasks > Import. 

4. The Certificate Import Wizard opens. 

5. On the Certificate Import Wizard Welcome page, click Next. 

6. On the File to Import page, click Browse and select the backed up certificate. Click Next. 

7. On the Private key protection page, enter the password and click Next. 

8. On the Certificate Store page, select the Place all certificates in the following folder option, 
click Browse, and select the Personal node. Click Next. 

9. On the Completing the Certificate Export Wizard page, click Finish. 
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